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Introduction

 

elcome to the Adobe

 



 

 PostScript

 

  

 

Printer Driver Version 8.3.1 
for the Macintosh

 



 

. The Adobe Printer Driver works with any 
Adobe PostScript printer and lets you take full advantage of 

your printer’s features and capabilities. 

The Adobe Printer Driver offers the following features:

 

•

 

Full support for all your printer’s features, including multiple input 
paper trays or output bins, duplex (two-sided) printing, and other print 
enhancement technologies, specified by PostScript Printer Description 
(PPD) files

 

•

 

Capability of saving PostScript files in a variety of portable formats

 

•

 

Maintenance of separate printer settings for each PostScript printer, 
making it easy to use two or more PostScript printers with the same 
computer

 

•

 

Automatic configuration for PostScript printers that support this 
feature 

 

•

 

Setup and configuration of disconnected printers and the capability of 
saving PostScript files for archiving until your computer is connected to 
a printer (via the Virtual Printer feature)

 

•

 

Capability of defining and printing custom media sizes from most 
applications to printers that support this feature

 

•

 

Capability of saving unique printer-specific settings as Adobe Printer 
Driver software defaults for each printer you use

 

•

 

Support for all PostScript Level 1 and Level 2 printers, imagesetters, 
and film recorders

 

•

 

System-level support for the Apple

 



 

 ColorSync

 



 

 software, which 
aids in providing accurate color matching between system monitors, 
scanners, and printers 

The Adobe Printer Driver is an operating system program that lets appli-
cation programs communicate with printers. The Adobe Printer Driver 
translates your application’s documents into the PostScript language and 

 

W
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I N T R O D U C T I O N

 

sends the PostScript document descriptions to your printer. The driver 
also provides information about your printer, such as available paper 
sizes and memory, resolution, and so on.

The Adobe Printer Driver supports PostScript Type 1 fonts (including 
multiple master fonts), TrueType

 



 

 fonts, and the Apple QuickDraw

 



 

 GX 
fonts, and can automatically download fonts to your printer. You can use 
the Adobe Printer Driver to save your documents as PostScript files to 
send to a service bureau. You can also create Encapsulated PostScript 
(EPS) files so that graphic images you create with one application and 
place in the documents of another application print with the greatest 
possible quality.

 

About this guide

 

This user guide explains how to install and use the Adobe Printer Driver 
with your Macintosh computer. In addition, Appendix A contains advice 
on troubleshooting printer problems, and Appendix B describes the 
printer options enabled by the generic PostScript Printer Description 
built into the Adobe Printer Driver.

The ReadMe file included on the PSPrinter 1 disk contains the latest 
information about the Adobe Printer Driver. The ReadMe file also 
contains instructions for using the Adobe Printer Driver with your 
printer model and with specific applications. You can read or print the 
ReadMe file with any word-processing program supported by the 
Macintosh. 

This manual assumes a basic familiarity with Macintosh operations and 
terminology. For instructions on basic Macintosh operations, refer to 
your Apple documentation.
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System requirements

 

The Adobe Printer Driver requires the following hardware and software:

 

•

 

Any Apple Macintosh computer that is running System 7 or later (The 
Adobe Printer Driver does not run on the Macintosh 128K, 512K, and 
512Ke computers.)

 

•

 

4 MB (megabytes) or more of memory 

 

•

 

700K (kilobytes) of available space on the hard disk and space, as 
needed, for PostScript Printer Description (PPD) files 

 

•

 

Version 7.3 or later of the Chooser utility

 

•

 

Apple ColorSync 2.0, if using the driver ColorSync features (The 
Adobe Printer Driver does not support ColorSync 1.x releases.)

 

Note

 

: To use the Adobe Printer Driver, Apple QuickDraw GX cannot be 
running on your system.

 

The Adobe Printer Driver package

 

The contents of the Adobe Printer Driver package include the following:

 

•

 

Adobe Printer Driver installation disks, containing the Adobe Printer 
Driver, Installer, the Chooser 7.3 utility, the Adobe Printer Driver 
ReadMe file, and PPD files

 

•

 

This guide, the 

 

Adobe PostScript Printer Driver User Guide, Macintosh 
Version 8.3.1

 

•

 

End-user license agreement
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Chapter 

 

1

 

: Installing the Adobe 

Printer Driver

 

his chapter explains how to install the Adobe Printer Driver 
on your computer and how to set up the driver to work with 
your printer. 

 

Installing the Adobe Printer Driver

 

Installing the driver is a two-step process. First, install the driver 
program, and then set up the driver to work with your printer.

For safekeeping, make backup copies of the Adobe Printer Driver Instal-
lation disks before installing the printer driver. If you need help on 
making a backup copy, see your Macintosh documentation.

 

To install the Adobe Printer Driver program:

 

1

 

Insert the copy that you made of the Adobe Printer Driver PSPrinter 1 
disk into your floppy disk drive. The Adobe Printer Driver Installation 
disk window opens on your desktop.

 

2

 

Double-click the ReadMe file and read the document for the latest 
information on your Adobe Printer Driver product. When you are 
finished, choose Quit from the File menu.

 

3

 

Remove or turn off any virus protection software.

 

4

 

Double-click the Adobe Installer program icon. The splash screen and 
then the Adobe Printer Driver Installer dialog box appear.

 

T
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5

 

To begin the installation process, choose one of two options:

 

•

 

To install all possible PPDs on your hard disk, click Install. You must 
have at least 8 MB of available disk space to install all PPDs.

 

•

 

To conserve disk space and install only the PPDs specific to your 
printer manufacturer or printer family, click Customize. 

In the Customize dialog, choose PSPrinter and the names of the manu-
facturers of printers whose PPDs you wish to install. You can also choose 
ReadMe if you wish to install and read that file later. Once you have 
chosen all the items you wish to install, click Install.

 

Note

 

:

 

 Adobe recommends the Customize procedure because it conserves disk 
space by letting you install only the PPDs you need now. If your needs 
change, you can later install other necessary PPDs.

 

6

 

If other applications are running, the Installer displays another dialog 
box asking whether you want to continue. To continue and quit all 
running applications, click Continue. No other applications can be 
running when you install new software. 

Follow the Installer’s instructions about changing installation disks. The 
Installer copies the Adobe Printer Driver and the Printer Descriptions 
folder (for PostScript Printer Description files, which completely 
describe a printer’s features) into the Extensions folder of the System 
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Folder. It copies the ReadMe file to the top level of your hard disk. If 
required, the Installer copies the new version of the Chooser into the 
Apple Menu Items folder of the System Folder. 

 

Note:

 

 The Adobe Printer Driver does not function properly without Chooser 
7.3 or later. If you do not use the Installer but instead drag the software from 
the installation disk to the System Folder on your hard disk manually, copy 
both the Chooser and PSPrinter 8.3.1 to your System Folder.

 

7

 

Replace or turn on any virus protection software that you removed 
in step 3.

 

Setting up the driver to work with your printer

 

Next, you need to select a printer and set up the driver to work with the 
selected printer. To set up the driver, you select a PostScript Printer 
Description (PPD) file to use with your printer. The driver uses the 
information in the PPD file to give you control of all your printer’s 
features.

 

Note:

 

 If you do not have a PPD file for your printer, you can use the Generic 
PPD built into the Adobe Printer Driver. The Generic PPD lets you print 
and gives you minimal control of your printer’s features; for a list of the 
options provided in the Generic PPD, see Appendix B.

 

Selecting and automatically configuring a printer

 

This section describes how to use the Chooser to select a printer, adjust 
background printing, and automatically configure the selected printer. 

 

To select a printer:

 

1

 

If you are using a local printer, connect it to your computer and turn 
both of them on.

 

2

 

Select Chooser from the Apple menu, and click the PSPrinter icon. You 
might need to scroll down to locate the PSPrinter icon.

 

Note

 

:

 

 If Apple QuickDraw GX is running on your system, you might not be 
able to choose the PSPrinter icon. To make the PSPrinter icon available, 
turn off QuickDraw GX.
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3

 

Select the zone in which your printer resides, if necessary. You might 
need to scroll through the list of zones and printers to find the one that 
you want to use.

 

4

 

Click the name of the printer that you want to use in the list in the 
upper right scroll pane of the Chooser. A message appears reminding 
you to click Setup to assign a PPD after selecting the printer. 

 

Note:

 

 If you have selected a color printer and have installed the Apple 
ColorSync software, you can select the monitor that the Adobe Printer 
Driver references when sending color coordinates to the printer. To select a 
system monitor, see the Apple ColorSync documentation.

 

5

 

To be reminded to click Setup each time you select a printer, click OK. 
To eliminate this message, click the check box; then click OK.

 

6

 

Adjust background printing, if desired.

Click On (the default) if you want the computer to be able to do other 
work while a file is printing. Otherwise, click Off.

 

7

 

Click Setup. For most printers, the Adobe Printer Driver searches for a 
PPD file that matches the model of the selected PostScript printer and 
automatically configures the driver to match the printer. 
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If the Adobe Printer Driver finds a match and the PPD file supports auto-
matic configuration, you have completed the setup of the driver; an icon 
appears to the left of the printer name in the Chooser to show that the 
driver is set up to work with that printer. The icons indicate the type of 
printer that you have just set up and might look like any of the following:

If the Adobe Printer Driver cannot find the appropriate PPD file, you 
must manually select a PPD. For more information, see “Selecting the 
PostScript Printer Description (PPD) File Manually” on page 10.

If the PPD file does not support automatic configuration, you must 
manually configure the installed options. For information on manually 
configuring installed options, see “Configuring Options in the PPD File” 
on page 15.

The remaining sections of this chapter explain how to change the PPD 
file after initial setup, how to configure the driver after changing your 
printer’s configuration, how to display printer information, and how to 
access the Help facility.

For instructions on how to change print options for different kinds of 
documents, see Chapter 2, “Setting Print Options and Printing.”

Standard page

printer

High-resolution

printer/imagesetter

Color printer

Generic PPD Spooler
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Selecting the PostScript Printer Description (PPD) file manually

 

This section explains how to select the PPD file to use with your printer 
manually if the Adobe Printer Driver is unable to select it automatically. 
For example, if you choose a spooler (a print-queuing device) as the 
printer, you might have to select the PPD file manually.

 

Note:

 

 If you click Cancel at any time in this procedure, the Adobe Printer 
Driver returns you to the Chooser, and the driver is set up to work with your 
printer via the Generic PPD; for a list of options provided in the Generic 
PPD, see Appendix B.

 

To select the PPD file manually

 

:

 

1

 

Select a printer, as described in the previous section, “Selecting and 
Automatically Configuring a Printer.”

 

2

 

If the Adobe Printer Driver cannot automatically set up the driver, it 
requests one of the following actions:

 

•

 

If the Adobe Printer Driver discovers no PPD files that match the 
selected printer, you must choose a PPD file manually. The Adobe 
Printer Driver displays a complete list of the PPD files now available on 
your computer hard disk, similar to the following dialog box.

 

Note

 

:

 

 If the Printer Descriptions list in the following dialog box does not 
contain the desired PPD, you can use the Generic PPD or install the desired 
PPD from the PSPrinter 2 or PSPrinter 3 disk. To install the PPD from the 
installation disks, follow the Customize method, described in “Installing the 
Adobe Printer Driver,” on page 5. Install only the desired PPDs; do not rein-
stall the Adobe Printer Driver. Once you have installed the desired PPDs, 
begin this procedure again.
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For information on the selected printer, click Info. To select the Generic 
PPD, click Use Generic. To select another PPD file, click the PPD name; 
then click Select. If the selected PPD does not support automatic config-
uration, the driver displays a Configure dialog box similar to the 
following:

The Configure dialog box shows the installable options possible for the 
selected PPD file. If more than four options are available, scroll through 
the list of pop-up menu items. Press the downward arrow for each 
option that you want to configure, and then release on the value that you 
want to assign to that option. When you are satisfied with the values, 
click OK.
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•

 

If the Adobe Printer Driver finds more than one PPD file that matches 
the selected printer, choose from the matching subset of all available 
PPD files. The Adobe Printer Driver displays a dialog box similar to the 
following:

Click the name of the PPD file to use; then click Select. For information 
on the currently selected printer, click Info. If you want to view all avail-
able PPD files, click Other; a complete list of the available PPDs appears. 
Click the name of the PPD file that you want to use, then click Select. 

 

•

 

If the Adobe Printer Driver finds a match, but the PPD file does not 
support automatic configuration, manually configure the printer. A 
Configure dialog box appears. Assign values to the installable options, as 
described in the first bullet of step 2.

 

Changing the current PPD file

 

You use the Setup option to change the current PPD file for a selected 
printer after the initial setup. 

 

To change the selected PPD file:

 

1

 

Select Chooser from the Apple menu, and click the PSPrinter icon. You 
might need to scroll down to locate the PSPrinter icon.
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2

 

In the upper right scroll pane of the Chooser, double-click the name of 
the PostScript printer for which you want to change the PPD file. 
Optionally, select the name of the printer, and then click Setup. 

 

3

 

Choose one of two options:

 

•

 

To let the Adobe Printer Driver automatically select a new PPD file, 
click Auto Setup in the Setup dialog box. If the Adobe Printer Driver 
cannot automatically set up the printer, you must manually set it up. For 
more information, see “Selecting the PostScript Printer Description 
(PPD) File Manually” on page 10.

 

•

 

To select a specific PPD file, click Select PPD. The Adobe Printer Driver 
displays a dialog box showing the PPD files that exist in the Printer 
Descriptions folder in the Extensions folder. Click the name of the PPD 
file that you want to use; then click Select. If none of the PPD files seems 
to match your printer model, you can either use the Generic PPD, use a 
PPD file for another printer similar to yours, or cancel the operation. To 
use the Generic PPD, click Use Generic. To select a similar printer’s PPD 
file, click the name from the PPD files listed, and click Select. To cancel 
and return to the Setup dialog box, click Cancel.

 

Selecting a PPD file when your computer is not connected to the 
desired printer

 

You might wish to set up the driver to work with a printer that is turned 
off or not now connected to the computer you are using, either directly 
or over the network. This feature, called Virtual Printer, can be handy if 
you are working on a portable computer, for example, and need to adjust 
the margins associated with the Page Size value or view a document via 
Print Preview or Page Layout. This feature is called 

 

virtual

 

 because it 
associates the document with the attributes of a specific printer, rather 
than with the physical device itself.
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To select a PPD file when your computer is not connected to the 
desired printer:

 

1

 

Select Chooser from the Apple menu and click the PSPrinter icon. You 
might need to scroll down to locate the PSPrinter icon.

 

2

 

From the Type menu, choose Virtual Printer. The Adobe Virtual 
Printer Driver screen appears. When you first set up the Virtual Printer, 
the selected printer type is Generic.

3 Click Setup. The Adobe Printer Driver displays a dialog box showing 
the PPD files that exist in the Printer Descriptions folder in the Exten-
sions folder. 

4 Click the name of the PPD file that you want to use, and then click 
Select. If required, the driver displays a Configure dialog box showing the 
installable options. 

Note: If you do not select a PPD, the Adobe Printer Driver uses the 
Generic PPD.

5 Manually configure Virtual Printer by scrolling through the list of 
pop-up menu items and pressing the downward arrow for each option 
that you want to configure, as required. Then release on the value that 
you want to assign to that option. When you are satisfied with the values, 
click OK. 
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Configuring options in the PPD file
Some printers support additional installation options for which you can 
configure your printer. For information on configuring your printer, see 
your printer documentation. If you do change the configuration of your 
printer, you should notify the Adobe Printer Driver of the current set of 
installed options. To do so, use the Configure option.

To notify the Adobe Printer Driver of the installed options:

1 Click Configure in the Setup dialog box. The installable options for the 
selected PPD file appear. For example, for some printers, the amount 
of memory installed in the printer is configurable and can be upgraded, 
as follows:

2 Select the value for the option to configure.

If more than four options are available, scroll through the list of pop-up 
menu items, press the downward arrow for each option that you want to 
configure, and then release on the value that you want to assign to that 
option. 

3 When you have finished configuring the installable options, click OK. 
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Displaying printer information
The Adobe Printer Driver provides a feature that lets you display infor-
mation about the printer selected in the Chooser. This feature displays 
the printer name, zone, product type, PostScript version and level, 
printer resolution, fax support, memory installed and available, binary 
communications support, color support, and the name of the PPD file 
associated with the printer. To use this feature, select the Printer Info 
option in the Setup dialog box.

Using the Help facility
For more information about the Adobe Printer Driver setup features, 
click Help in the Setup dialog box, or select Show Balloons from the Help 
menu.
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Chapter 2: Setting Print Options 

and Printing

his chapter explains how to change page-setup and print 
options. It also explains how to print to a printer or a 
PostScript file.

Setting page-setup options with the Adobe Printer Driver
The Adobe Printer Driver provides the page-setup options described in 
the following sections. The following sections do not describe any appli-
cation-specific page-setup options that might appear under the page 
orientation options in the PSPrinter Page Setup dialog box. For informa-
tion on those options, see the documentation for your application.

For most applications, page-setup options that you set with the Adobe 
Printer Driver remain in effect on a document-by-document basis until 
you change them.

To use the Page Setup dialog box to change page-setup options:

1 From the File menu of your application, select Page Setup.

2 Select the values you want for the page-setup options described in the 
next section.

T
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Paper
Use this option to choose any paper size that your printer supports. The 
default is normally 8.5 by 11 inches (US Letter). However, when the 
Adobe Printer Driver is configured for markets other than the United 
States, the default paper size is A4. Paper size options vary with printer 
model. For a description of the paper sizes supported by your printer, 
refer to your printer documentation. Make sure that the paper size you 
select matches the paper in the paper source. 

If your printer supports custom paper sizes, the Custom option is avail-
able in the Paper pop-up menu. If you select Custom, you can edit the 
dimensions of the page. For more information, see the following section, 
“Page Image.” 

Note: If you reconfigure the Adobe Printer Driver with a new printer that 
does not support the previously selected paper size or the Custom feature, 
the item “Other” is added to the Paper menu and selected as the default. Do 
not leave Other selected; select another Paper value, and click OK. 

Page image
This option shows the size, arrangement, and appearance of the printed 
results. The page image changes to reflect the layout options chosen. The 
outer, solid rectangle represents the edge of the physical paper; the inner, 
dotted rectangle represents the boundaries of the area in which the 
Adobe Printer Driver will print, called the imageable area.

For a listing of the dimensions of this image, click anywhere within 
the page image icon (see previous illustration). Dimensions include 
height and width of the paper size and the imageable area for the top, 
left, bottom, and right margins. Click a second time to view the values in 
alternate units (inches or millimeters). Click a third time to return to the 
page image.
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If the selected PPD allows you to select Custom as the Paper value and 
you select Custom, you can edit the image values to reflect the size of 
your paper. Click the page image anywhere to display the default numer-
ical dimensions. Use the Tab key to move through the dimensions and 
select the field that you want to edit. Enter the new value in millimeters 
or inches. For more information, see the preceding section, “Paper,” on 
page 18.

Note: Although you can specify Custom dimension values in millimeters or 
inches, the Adobe Printer Driver stores these values internally in points (one 
point equals 1/72 of an inch). You might notice a difference in reported 
dimensions because of the driver’s internal conversion from millimeters or 
inches to points.

If you have selected Custom as a Paper value, two types of paper devices 
are possible: roll-fed or cut-sheet. The default dimensions of the paper 
image vary according to the type of paper device.

Roll-fed Paper Device Type

Cut-sheet Paper Device Type

For roll-fed devices, no margin dimensions are necessary because the 
imageable area is the same as the requested page size, and the margins are 
fixed at zero. Four numerical dimensions are possible: width, height, 
width offset, and height offset. The width shows the size of the page 
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perpendicular to the direction of the paper device feed. The height is 
measured parallel to the direction of the paper device feed. The offsets 
are measured from the bottom left edge of the device. 

For cut-sheet devices, the page image icon lets you set width, height, and 
the left, top, right, and bottom margins.

Layout
Use this option to specify how the Adobe Printer Driver arranges pages 
on the paper. The Adobe Printer Driver adjusts the orientation of the 
physical page to best fit the orientation of the logical pages selected for 
printing. The following options are possible for the portrait and land-
scape orientations specified for the logical page. Several of these options 
are represented graphically on the next page: 

1 Up. This is the default; it prints one page of the document on the sheet 
of paper. For this layout option, the orientations of the physical and 
logical pages match.

2 Up. This option prints two pages of the document on the sheet of 
paper. For this layout option, the orientation of the physical page is 
opposite from the orientation of the logical page. 

4 Up. This option prints four pages of the document on the sheet of 
paper. For this layout option, the orientations of the physical and logical 
pages match.

6 Up. This option prints six pages of the document on the sheet of paper. 
For this layout option, the orientation of the physical page is opposite 
from the orientation of the logical page.

9 Up. This option prints nine pages of the document on the sheet of 
paper. For this layout option, the orientations of the physical and logical 
pages match.

16 Up. This option prints 16 pages of the document on the sheet of 
paper. For this layout option, the orientations of the physical and logical 
pages match.
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In all modes but 1 Up, lines appear around each document page 
arranged on the page of paper. Once you select a Layout value, the page 
image changes to reflect your selection.

Note: The PPD for a specific printer generally specifies the rotation direc-
tions for landscape orientation, which can vary among printer manufac-
turers. Depending on your PPD, landscape orientation on your printer 
might be different from that shown in the following graphic. Alternate 
landscape gives you the option of overriding the default rotation for land-
scape orientation in the PPD for your printer. For more information, see 
“Orientation” on page 22.

1-Up Portrait 1-Up Landscape 1-Up Alternate

2-Up Portrait 2-Up Landscape 2-Up Alternate

4-Up Portrait 4-Up Landscape 4-Up Alternate
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Reduce or enlarge
Use this option to reduce or enlarge the contents of the printed page. 
Scale factors range from 25 percent to 400 percent, and the default value 
is 100 percent. The Adobe Printer Driver prints out a single page and 
normally positions the enlarged or reduced image in the top left corner 
of that page. For enlargements over 100 percent, the printer’s paper size 
determines whether the enlarged image is partially or fully printed. If 
pages in the document are larger than the printer paper size, for example, 
a complete image is not printed. The Adobe Printer Driver does not 
automatically print an image over several pages (called tiling).

Orientation
Use these options to choose the direction in which your document is 
printed on the paper—either portrait, landscape, or alternate landscape. 
Portrait orientation means that the page is taller than it is wide; landscape 
orientation means that the page is wider than it is tall. 

Different printer manufacturers might have different preferred rotation 
directions for landscape orientation; usually the PPD file of the selected 
printer specifies the direction in which pages are automatically rotated 
from portrait to landscape orientation. The two landscape buttons in the 
Page Setup dialog box indicate in which direction the Adobe Printer 
Driver will rotate portrait pages to a landscape position—clockwise or 
counterclockwise.

The counterclockwise orientation option is usually the best choice if you 
want hole punches to appear at the top of your landscape page. However, 
you should print a test page to verify that the selected landscape option 
and the position of the three-holed paper in the printer’s paper tray 
produce the desired results. If they do not, change the landscape option 
accordingly.
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Options
Use the Options button to specify further layout and formatting infor-
mation. The Options dialog box provides the following possible options 
and defaults, depending on the PPD you have selected: 

Note: If you have specified a layout value other than 1 Up and an orienta-
tion value of landscape or alternate landscape, you cannot use the Flip 
Horizontal or Flip Vertical options of the Options dialog box. Also, to print 
a document upside down, turn on both the Flip Horizontal and Flip Vertical 
options. 

Flip Horizontal. Use this option to print a mirror image of the 
document.

Flip Vertical. Use this option to print a mirror image of the document 
upside down. 

Invert Image. Use this option to print the white areas of the document 
black and the black areas of the document white.

Substitute Fonts. Use this option to let the printer substitute available 
fonts during printing. The printer substitutes Helvetica for Geneva, 
Courier for Monaco, and Times for New York. By default, this option is 
turned on.

Smooth Graphics. Use this option to improve the quality of screen-
resolution graphic images by smoothing the jagged edges. By default, 
this option is turned on.

Precision Bitmap Alignment. Use this option to reduce the printed 
document appropriately according to the resolution of the printer. This 
option might provide greater readability of your screen-resolution 
bitmapped images. 
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Unlimited Downloadable Fonts in a Document. Use this option if you 
want to use a large number of fonts in a document and have them sent 
to the printer as needed to print but your printer has limited memory 
installed. Do not use this option for print jobs that contain multiple 
master fonts.

Larger Print Area. Use this option to print on more area of the page. This 
option uses more printer memory and therefore limits the number of 
downloadable fonts. Downloadable fonts are stored separately from the 
printer and sent to it at the time of printing. Not all printers support 
multiple print areas on all paper sizes. If the selected printer does not 
support multiple print areas for this paper size, this option is unavail-
able. The availability of this option depends on the PPD and paper type 
that you select and whether the selected printer supports the Larger Print 
Area.

The Adobe Printer Driver also provides a Help button in the Options 
dialog box, offering explanations of the layout and formatting options. 

To save the settings you specify in the Options dialog box as default 
values, when exiting the dialog box click OK while holding down 
the Option key.

Setting print options with the Adobe Printer Driver
You can use the Adobe Printer Driver to select various print options, 
such as which pages of the document to print, paper source, and so on.

The Adobe Printer Driver itself provides several options, described in the 
following sections. The following sections do not describe any applica-
tion-specific print options that might appear under the Paper Source 
and Destination boxes in the Print dialog box. For information on those 
options, see the documentation for your application.
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To use the Print dialog box to change print options:

1 In the File menu of your application, select Print. The Print dialog box 
appears.

2 Select the values you want for the print options described in the 
following sections. 

Copies
Use this option to specify the number of copies of the document that you 
want the printer to print.

Pages
Use this option to specify which pages of the document to print. To print 
the whole document, click All (the default). To print a range of pages, 
type the first page to print in the From field and the last page to print in 
the To field; the Adobe Printer Driver prints the first and last pages and 
all pages between those pages.

Paper source
Use this option to choose how paper is provided to the printer—auto-
matically from specific paper trays or manually. Paper source options 
vary with printer model. You can specify a single source for all paper or 
different sources for the first and remaining pages. This feature is handy, 
for example, if you want company letterhead to be used for only the first 
page of a document. The default value is All, for a single source for all 
paper.
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Destination
Use this option to choose from two destinations to which the Adobe 
Printer Driver can send data from your application:

• Printer, the default value, which specifies that the data is sent to 
a printer

• File, which specifies that the data is saved to a disk file in a format you 
choose

The default value is normally Printer. If you choose a destination other 
than Printer for a print job, once that print job is complete the value is 
restored to Printer. If you are setting up a virtual printer, however, the 
value is always File. 

Options
Click the Options button in the Print dialog box to access the options 
described in the following paragraphs.

Some options that you can set in the Print Options dialog box vary from 
printer to printer. These differences include duplex printing, printer 
resolution settings, image enhancement functions, watermark selection 
and modification, and so on. The availability of these options depends 
on the selected printer model and the way in which the driver is config-
ured for that printer. The Print Options dialog box is similar to the 
following:

The settings for Cover Page, Print (Color/Grayscale), and PostScript 
Errors remain intact from document to document. The values for 
printer-specific settings—those that appear below the dotted line in 
the Print Options dialog box—can be saved as Adobe Printer Driver 
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software defaults. To save these values as defaults, click the Save button 
on the Print Options dialog box. Each time that you print to this printer, 
the Adobe Printer Driver returns to these default settings. 

Note: The Printer’s default value for the printer-specific values tells the 
driver to use the values that have been manually set on the printer’s front 
panel. 

Cover Page. Use these options to specify the presence and position of 
the document’s cover page. The generic cover page built into the Adobe 
Printer Driver includes the name of the user, application name, docu-
ment name, date and time, printer name, and number of pages in 
the job.

Print. Use these options to specify whether and how to print the docu-
ment in color. 

The Color/Grayscale option (the default) provides for color printing 
and, for monochrome printers, maps colors to equivalent PostScript 
grayscale shades. Color/Grayscale imaging generally produces better 
visuals than does black-and-white, even on monochrome printers.

The Black and White option limits printing to monochrome only. Use 
this option if you want the same output as you used to obtain using the 
Apple LaserWriter  7. x printer driver with black-and-white printers. 
Most users will not use this option. 

The ColorSync Color Matching option provides for color conversion 
on the Macintosh and supports PostScript Level 1 and Level 2 printers. 
This option requires a printer profile and is available only if the 
ColorSync software is installed. Choose this option if your Macintosh 
processor is faster and more powerful than your printer. If you want 
color conversions and have only a PostScript Level 1 printer, you must 
use this option.

The PostScript Color Matching option provides for color conversion on 
the printer. Use this option if your printer is not now color calibrated and 
is a PostScript Level 2 printer. This option requires you to select a printer 
profile. If you are using a Printer Profile selection other than Printer’s 
Default, this option generates device-dependent color, using color-
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rendering dictionaries downloaded from the computer to the printer. If 
you are using the Printer’s Default selection, this option uses the device-
independent color capabilities built into every PostScript Level 2 printer.

Note: When selecting Printer Profile > Printer’s Default, consider that some 
printers might not provide all the built-in color-rendering dictionaries for 
the various paper types you want to use. In this case, select a specific printer 
profile that meets your needs from the Printer Profile menu. If a specific 
printer profile for your color printer does not appear in the Printer Profiles 
menu, you might not have one for your printer, and you should contact your 
printer manufacturer.

Printer Profile: Use this option to choose a printer profile for your color 
printer. If using the ColorSync Color Matching or PostScript Color 
Matching option described above, you must select a Printer Profile value. 
Generally , if ColorSync software and printer profiles are unavailable 
on your system, this option is unavailable. However, if you choose 
Print > PostScript Color Matching, the Printer Profile > Printer’s Default 
option is available. 

PostScript Errors. Use this option to specify the level of error reporting 
for PostScript errors that might occur during the course of printing.

The No Special Reporting option (the default) provides no detailed 
information about the PostScript error.

The Summarize on Screen option displays a message describing on the 
monitor screen the nature of the PostScript error. This feature is avail-
able only when background printing is turned off.

The Print Detailed Report option prints to the printer a report 
describing the PostScript error.

Printing to a printer
Once you have set the page-setup and print options for your document, 
you can print the document on your printer. 

To print a document on your printer:

1 In the Print dialog box, select Printer in the Destination box.

2 Click Print.
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Printing to a file
As an alternative to printing your document on your printer, you can 
save a PostScript language description of your document as a disk file. 
PostScript language descriptions of your documents can be useful for 
creating document archives or printing documents without using the 
application that created them (at a service bureau, for example).

Another use of printing to a file is to create an Encapsulated PostScript 
(EPS) file. You can use EPS files to export single pages from one applica-
tion to another. EPS files can include any combination of text, graphics, 
and images, but they do not describe complete documents. For example, 
by saving a page as an EPS file, you can insert a page of a document 
created with one application as an illustration into a document created 
by another application.

When printing to an EPS file, keep in mind the following:

• The Adobe Printer Driver cannot, by itself, ensure a correct EPS file. 
The application must also support EPS output by telling the Adobe 
Printer Driver where on the page the illustration or text is located. If, 
when you import EPS files generated by the Adobe Printer Driver into 
other applications, the displayed illustration looks distorted, your orig-
inal application is not providing the driver enough information to 
produce the preview correctly. You can, however, print the file correctly 
even without the correct preview. For more information on previews, see 
“Format” on page 31.

• Each EPS file can be no more than a single page. When using the appli-
cation’s Print dialog box, be sure to enter the same page number in the 
From and To fields so that only one page is created for each EPS file.

• EPS files generated by the Adobe Printer Driver provide two types 
of on-screen preview and an option for no preview, as described in 
“Format” on page 31. 
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To print to a file:

1 In the Print dialog box, select File from the Destination box; then click 
the Save button. The Save dialog box appears.

Note: No cover page or error handler information is saved with the Post-
Script language description of your document, even if you have previously 
selected these print and page-setup options.

2 Select the name of the file folder in which to save the PostScript file. 

To create a new folder in which to place the PostScript file, click New 
Folder, and specify the name of the new folder.

Note: The extension on the default filename in the Create File field changes 
automatically when you change the Format value for the file.

3 In the Create File field, change the name of the file to contain the 
PostScript document if desired. 

4 Specify the details on how to save the file. The possible options are 
described in the following sections. 

5 Click the Save button. The file is saved to the specified file and file 
folder, and you are returned to your application. All Save options return 
to the default values each time you select Save.
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Format
Use these options to choose the PostScript, Encapsulated PostScript, or 
Printer Job Language (PJL) format in which to save a document. The 
following values are possible:

PostScript Job. This option provides a copy of the Adobe Printer Driver’s 
PostScript output exactly as it would have been sent to the output device. 
PostScript Job is the default option.

Note: Because a document’s cover page is printed as a separate job, it is 
excluded from the version of the document saved to a file, even if you request 
it in the Print Options dialog box.

EPS Mac Standard Preview. This option provides a 72-dots-per-inch 
(dpi) bitmap monochrome preview image for displaying the page on 
the Macintosh screen. The preview image of an EPS file created using 
this format option might appear distorted when placed into other 
applications.

EPS Mac Enhanced Preview. This option provides a QuickDraw PICT 
format as a preview for displaying the page on the Macintosh screen. The 
preview image of an EPS file created using this format option scales accu-
rately (without jagged edges) when placed into other applications.

EPS No Preview. This option provides no associated preview image 
for displaying the page on a Macintosh screen. This format is intended 
for transfer to computers other than a Macintosh. If you choose this 
option, the preview images of the EPS-generated files appear as blank or 
black boxes—or as a box containing an X, when imported into other 
applications.

Note: Some applications do not provide enough data to create a preview. In 
such cases, parts of the preview might be missing. Also, remember that EPS 
files can be no more than a single page.

PJL Job. This format is available only when you select a printer that 
supports PJL. This option lets you save the document in the HP Printer 
Job Language, to print as a PostScript job with embedded PJL 
commands. If you save the document in PJL, it will print correctly only 
on a printer that supports PJL. 
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ASCII/Binary
Use these options to specify whether a PostScript Job or PJL Job file 
should be saved in ASCII or binary format. EPS files are always saved in 
ASCII format. 

ASCII. PostScript files are normally ASCII text files that can be opened 
with any word-processing application. The default value is ASCII.

Binary. Binary encoding speeds printing. Your printer must be set up to 
receive binary data; otherwise, selecting this option might cause printing 
errors. (Most printers connected over LocalTalk  or EtherTalk  are set up 
automatically to receive binary data.)

Note: If you select the Binary or PJL option in the Save dialog box, the Post-
Script files can include binary or control characters, which might make 
them unsuitable for use with word processors and certain telecommunica-
tions applications and print spoolers. If you intend to transfer the PostScript 
file over telecommunications services or through print spoolers, the services 
must fully support binary or PJL data transfer, as needed.

Level of PostScript compatibility
Use these options to specify the level of PostScript compatibility for the 
file to be saved.

Level 1 Compatible. This option (the default) specifies compatibility 
with all PostScript printers.

Level 2 Only. This option specifies compatibility with Level 2 printers 
only. Using Level 2 features speeds printing and is the recommended 
setting. However, PostScript files created with this option will most likely 
not print correctly on a PostScript Level 1 printer. Use this setting for all 
Level 2 printers and if you are creating files that will later be converted to 
PDF format with Adobe Acrobat Distiller.
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Font inclusion
Use these options to include downloadable fonts in the PostScript file. 
The following values are possible:

None. Select this option (the default) if you assume all needed fonts are 
already available on the device where the file will be viewed or printed 
and you want to include no fonts.

All. Select this option to include all fonts that are used in the document 
and that are available on the host Macintosh.

All But Standard 13. Select this option to include all fonts that are used 
in the document and that are available on the host Macintosh—except 
the core set of 13 standard fonts that most PostScript printers support. 

The core set of 13 standard fonts includes Courier, Symbol, Helvetica, 
Times Roman, and their variations, such as bold and oblique.

All But Standard 35. Select this option to include all fonts that are used 
in the document and that are available on the host Macintosh—except 
the set of 35 standard fonts that many PostScript printers support.

The set of 35 standard fonts includes the standard 13 fonts and Avant 
Garde, Bookman, Helvetica Narrow, New Century Schoolbook, 
Palatino, Zapf Chancery, Zapf Dingbats, and their variations.

All But Fonts in PPD File. Select this option to include any fonts that 
appear in the document but are not listed in the PPD file as resident on 
the printer.

Note: If you know the printer on which the document will be printed, the 
All But Fonts in PPD File option is recommended. If you do not know the 
printer on which the document will be printed, the All But Standard 13 
option is recommended.
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Appendix A: Troubleshooting

This appendix offers solutions to problems that you may encounter 
using the Adobe Printer Driver.

When the Adobe Printer Driver detects a problem, it displays an alert 
message describing the problem. If you receive an alert message, follow 
any instructions provided in the message. 

If you have a problem but do not receive an alert message, look through 
the following list of problems to find the solution. If you don’t find a 
description of your problem in this appendix, refer to the ReadMe file on 
your installation disk. If after checking the troubleshooting topics in this 
appendix and the ReadMe file you still need help, contact your printer 
manufacturer or application vendor.

The printer isn’t working

Problem: You’ve installed the Adobe Printer Driver and set up the driver 
for your printer, but your printer isn’t working. A number of problems 
can cause your printer to fail to print:

• The printer is not turned on.

• The printer is not connected correctly to your computer or network.

• The printer is not selected in the Chooser.

• The printer is broken.

Solution: Check for these problems in the preceding sequence. If you 
cannot correct the problem, carefully repeat the installation instructions 
in your printer documentation. If the printer still does not work, contact 
your printer dealer or printer manufacturer for help.
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The printer stops printing

Problem: You try to print a document, but the printer stops printing 
before the entire document has printed. A number of problems can 
cause your printer to stop printing:

• The computer memory is too low to print the entire document.

• The printer requires more memory than is available to print a 
complicated page.

• The printer encounters a PostScript language error while interpreting 
the PostScript language description of your document.

• The output from the application is incorrect or incomplete.

Solution: If the Macintosh computer memory is low (which is usually 
the case if the alert message doesn’t indicate a specific device), you can 
make more memory available by reducing the number of applications 
that you run at the same time, by allocating more memory to your 
printing application using the Macintosh Get Info function, or by 
purchasing additional memory. 

If the alert message indicates a memory problem in the printer, continue 
printing. If the resulting output is unsatisfactory, increase the memory 
in the printer, reduce the number of fonts used in the document, or print 
the document in smaller portions.

The Unlimited Downloadable Fonts in a Document printer option 
also helps you to manage printer memory. To set that option, select 
Options in the Page Setup dialog box; the Options dialog box appears. 
In the Options dialog box, click Unlimited Downloadable Fonts in a 
Document.

To determine whether a PostScript error is at fault, choose Print from the 
File menu; click Options; in the Print Options dialog box, select Print 
Detailed Report for the PostScript Errors option, and print the docu-
ment again. If a PostScript error occurs, the printer prints an error page. 
For help in understanding the error condition, contact your application 
vendor.

If you cannot correct the problem, contact your printer dealer or printer 
manufacturer for help.
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An alert message indicating that the Preferences file is damaged or 
not found appears when you are using the Print or Page Setup 
option

Problem: This problem can arise under one of three conditions: when 
your computer has inadequate available disk space to parse the Post-
Script Printer Description file, when the Preferences file is missing, or 
when the Preferences file contains incorrect information. 

Solution: If less than 100K of disk space is available, you may receive 
messages about the selected PPD and a suggestion to delete the Prefer-
ences file. Do not delete the Preferences file; instead, make at least 100K 
of space available on your hard disk, and select and set up the printer 
again.

If the Preferences file is missing, it may not have been created when you 
first tried to set up your printer or first printed after installing the Adobe 
Printer Driver. Select and set up the printer again. 

If you suspect that the Preferences file contains incorrect information, 
the old Preferences file may not have been deleted when the driver was 
setting up a new printer. Delete the PSPrinter Prefs file in the Preferences 
folder of the System Folder. Select and set up the printer again.

The Virtual Printer feature is not available

Problem: You want to set up a virtual printer, but Virtual Printer is 
unavailable in the Type menu in the Chooser. 

Solution: The correct version of the Chooser is not installed on the 
computer or is not being used. To set up a virtual printer, you must be 
running version 7.3 or higher of the Chooser. Make sure the correct 
version of the Chooser is installed in the Apple Menu Items folder of the 
System Folder. If the correct version is not installed, copy it from the 
installation disk.
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The driver does not automatically set up the selected printer

Problem: You are running System 7 on your Macintosh computer, and 
you have clicked Setup in the Chooser or Auto Select in the Resetup 
dialog box, but the driver does not automatically set up the selected 
printer.

Solution: You may be missing the PPD file, or the PPD folder may be 
named incorrectly. The PPD folder can be named only “Printer Descrip-
tions.” Make sure that the PPD folder is named Printer Descriptions. 
Also verify that all of the PPD files are in the PPD folder and that the 
folder resides in the Extensions folder within the System Folder. If you 
are missing the required PPD file, see your system administrator or your 
printer vendor.

If after you try to resolve the problem following the above suggestions, 
the problem still exists, your printer might not support the Auto Setup 
feature.

You can’t set the print time in the PrintMonitor dialog box

Problem: You cannot set the print time in the PrintMonitor dialog box, 
and an Alert dialog box indicating insufficient memory appears.

Solution: Click OK in the Alert dialog box, go to the Finder and choose 
PrintMonitor, and reset the print time.

The ColorSync Color Matching option is not available

Problem: The Print > ColorSync Color Matching option is unavailable in 
the Print Options dialog box.

Solution: The Apple ColorSync software might not be installed on your 
computer, or a ColorSync 1.x version might be installed. The Adobe 
Printer Driver does not support ColorSync 1.x releases. To use the driver 
ColorSync features, make sure that Apple ColorSync 2.0 is installed on 
your Macintosh.
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Your printouts do not print with the correct colors

Problem: You selected the Print > PostScript Color Matching or the 
Print > ColorSync Color Matching option and a Printer Profile option, 
but when you try to print to your color printer, the color looks wrong. 

Solution: You might have selected Printer Profile > Printer’s Default. If 
so, remember that some printers might not provide all the built-in color-
rendering dictionaries for the various paper types you want to use. Select 
a printer profile specific to your color printer. Contact your printer 
manufacturer if you do not have the proper color profile for your printer, 
or if you are unsure which is the correct profile for your printer.

An EPS file does not print with the correct colors

Problem: You created a color EPS file using the Adobe Printer Driver, but 
when you try to print a document containing the EPS file to your color 
printer, the color looks wrong. 

Solution: When creating the EPS file, you might have selected Printer 
Profile > Printer’s Default, which is often the proper choice. However, 
remember that some printers might not provide all the built-in color-
rendering dictionaries needed to print the EPS file correctly. Also, some 
applications are not sophisticated enough to tell the driver to download 
any missing color-rendering dictionaries from your Macintosh.

Choose one of these solutions to your problem:

• If you are printing to a high-end printer with most color-rendering 
capabilities built-in, select Printer Profile > Printer’s Default both when 
you are creating the EPS file and when you are printing the document 
embedded with the EPS file.

• If you are printing to a printer with limited built-in color-rendering 
capabilities, create the EPS file specifying the appropriate printer profile 
and specify the same printer profile when printing the document 
embedded with the EPS file. This solution ensures that the EPS file will 
print in the correct colors, but sacrifices file portability.

• Contact your printer manufacturer if you do not have the proper 
printer profile for your color printer.
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T R O U B L E S H O O T I N G

Appendix A

An EPS file does not print with the correct fonts

Problem: Your application is not downloading to the printer the fonts 
included with the EPS file when you saved it.

Solution: This problem occurs only with some applications. To correct 
this problem, download any fonts contained in the EPS file to the printer 
before printing the saved EPS file.
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Appendix B: Generic PostScript 

Printer Description Settings

The generic PostScript Printer Description defines the characteristics of 
a printer with the following features available on almost all PostScript 
printers:

• Cassette and manual paper sources

• Destination values of Printer and File, for sending data from your 
application

• Clockwise rotation of landscape pages

The following paper sizes:

• US Letter

• US Legal

• A4

• B5

If you choose a paper size from the Generic PPD that is not supported by 
the selected printer, the Adobe Printer Driver tries to print the job on 
whatever paper is currently loaded in the selected printer and uses the 
currently selected paper source on devices with more than one paper 
source.

In 1-up printing, if the available paper is smaller than the specified paper, 
the printed output may be clipped. If pages are printed 2-up or 4-up per 
physical sheet, the size of the available paper relative to the specified 
paper is not critical, because 2-up and 4-up pages always print in the 
imageable area of a page.
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Index

A

Adobe Printer Driver

destination for sending data from the 
application 26

icons 9

installation 5-7

list of features 1

memory requirements 3

product package 3

ReadMe file 2, 35

setting up for printer 7-16

supported fonts 2

system requirements 3

alert messages 35

alternate orientation 22

Apple ColorSync software

selecting monitor that the driver 
references 8

software compatibility with driver 1

Apple Quickdraw GX, fonts 2

archiving PostScript documents 29

ASCII format option, for saving to file 32

B

Binary format option, for saving to file 32

C

Chooser

installing manually 7

version requirements for the driver 37

color printing 27

configuration, installation options for the 
printer 15

custom paper, specifying dimensions 19

D

Dialog box

Page Setup 17

Page Setup Options 23

Print 25

Print Options 26

document

format options 31-32

printing 28

saving 30

downloading, font inclusion with PostScript 
file 33

E

Encapsulated PostScript (EPS)

considerations for printing to file 29

document formats 31

file definition 29

printing file without correct fonts 40

EPS. See Encapsulated PostScript (EPS)

F

File, printing to PostScript 29-30

Flip Horizontal option, of Page Setup 23

Flip Vertical option, of Page Setup 23

font inclusion with document, options 33

fonts

downloadable with PostScript file 33

supported by driver 2

Format options, for saving documents 31-32

H

Help, online 16

I
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I N D E X

Installation, printer driver software 5-7

Invert Image option, of Page Setup 23

L

Landscape orientation 22

Larger Print Area option, of Page Setup 24

layout, of pages on paper 20-21

O

Online help 16

Options dialog box

Page Setup 23

Print 26

orientation

of document on paper, types 22

of document pages in n-up printing 20-21

Other option, in Paper menu 18

P

Page image 18

Page Setup dialog box 17

Page Setup Options dialog box 23

page-setup options 17-24

layout 20-21

orientation 22

page image 18

paper 18

scaling 22

paper

custom 19

menu, Other option 18

PJL. See Printer Job Language (PJL)

portrait orientation 22

PostScript

compatibility with saved file 32

Errors option 28

file encoding 32

printing file to 29-30

PostScript printer

configuring installation options 15

Description (PPD). See PPD (PostScript 
Printer Description)

displaying information about 16

driver. See Adobe Printer Driver

Level 1 1, 32

Level 2 1, 32

selection with automatic configuration 7-9

PPD (PostScript Printer Description)

automatic selection 7-9

changing current selection 12-13

generic settings 41

how driver uses it 7

manual selection 10-12

selecting when printer is unavailable 13-14

Precision Bitmap Alignment option, of Page 
Setup 23

Print dialog box 25

print options 25-28

changing 24

Printer’s Default 27

Print Options dialog box 26

Printer Job Language (PJL) 31

Printer’s Default value 27

printing

to a PostScript file 29

R

ReadMe File for Adobe Printer Driver 2

requirements, system 3

S

Scaling the contents of a page 22

service bureau, creating PostScript files for 29

setting up

driver for printing to file 30

driver to work with printer 7-16
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Smooth Graphics option, of Page Setup 23

Substitute Fonts option, of Page Setup 23

system requirements 3

T

Troubleshooting

common problems 35-40

PostScript Errors option 28

U

Unlimited Downloadable Fonts in Document 
option, of Page Setup 24

V

Virtual Printer

correct Chooser version 37

selecting PPD when printer is 
unavailable 13-14
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